
10820-401-0200

Release Notes

June 4, 2003

Matrox RT.X100 Xtreme



Acrobat® Reader Copyright © 1987-2003 Adobe Systems Incorporated. All rights reserved. Adobe and Acrobat are trademarks of 
Adobe Systems Incorporated, which may be registered in certain jurisdictions.

• (English) All other nationally and internationally recognized trademarks and tradenames are hereby acknowledged. • (Français) Toutes 
les autres marques et tous les autres noms déposés reconnus nationalement ou internationalement sont également reconnus par les 
présentes. • (Deutsch) Alle sonstigen national und international bekannten Warenzeichen und Produktnamen werden hiermit anerkannt. 
• (Italiano) Eventuali altri nomi di prodotto menzionati in questo manuale sono dei proprietà di rispettivi produttori. • (Español) Por medio 
del presente se reconocen todas las demás marcas y nombres comerciales reconocidos a nivel nacional e internacional.

Copyright © 2003 Matrox Electronic Systems Ltd. • (English) All rights reserved. • (Français) Tous 
droits réservés. • (Deutsch) Alle Rechte vorbehalten. • (Italiano) Tutti i diritti riservati. • (Español) 
Reservados todos los derechos.
Disclaimer Matrox Electronic Systems Ltd. reserves the right to make changes in specifications at any time and without notice. The in-
formation provided by this document is believed to be accurate and reliable. However, no responsibility is assumed by Matrox Electronic 
Systems Ltd. for its use; nor for any infringements of patents or other rights of third parties resulting from its use. No license is granted 
under any patents or patent rights of Matrox Electronic Systems Ltd.
Unauthorized recording or use of broadcast television programming, video tape, or other copyrighted material may violate copyright laws. 
Matrox Electronic Systems Ltd. assumes no responsibility for the illegal duplication, use, or other acts that infringe on the rights of copyright 
owners.

Matrox Electronic Systems Ltd.
1055 St. Regis Blvd., Dorval, Quebec, Canada  H9P 2T4
Tel: (514) 685-2630 Fax: (514) 685-2853 World Wide Web: www.matrox.com

Trademarks • Marques déposées • Warenzeichen • Marchi registrati • Marcas registradas
Matrox Electronic Systems Ltd. ....................................... Matrox®, MediaExport™, MediaTools™, RT.X100 Xtreme™, X.tools™, 

XtremePreview™
Matrox Graphics Inc ........................................................ P650™, P750™, Parhelia™
Adobe Systems Inc. ........................................................ Adobe®, Premiere®

Creative Technology Ltd. ................................................. Audigy™, SoundBlaster™
Microsoft Corporation...................................................... Microsoft®, DirectShow®, NetMeeting®, Windows®, Windows 

Media™, Windows Media Player™
Sonic Foundry ................................................................. Vegas Video®

Sonic Solutions ............................................................... Sonic Solutions™, Sonic™, DVDit!®, ReelDVD Studio®



Contents

About these release notes .............................................................. 1

What’s new in this release of Matrox X.tools? ................................ 1

Installing Matrox X.tools...................................................................3

Installing ReelDVD Studio.................................................................3

Using the Windows Media version 9 video codec with 
MediaExport ....................................................................................4

Changes to the WYSIWYG DirectShow Control Panel.....................4

A note about DVD capacities ...........................................................4

Last-minute operational limitations..................................................5



ii
Your notes
Contents



1

About these release notes
These release notes provide a list of new features and other important last-minute 
information applicable to Matrox X.tools build 4263. This information 
supplements the Matrox RT.X100 Xtreme Installation and User Guide (May 1, 
2003).

¦ Note To make sure that you have the latest available software (updates and 
Service Packs) for your Matrox RT.X100 Xtreme system, check the Support 
section of our web site at:

www.matrox.com/videoweb/support

What’s new in this release of Matrox X.tools?
This release of Matrox X.tools provides a number of updates. Here are the main 
features:

• New features in the Matrox realtime plug-in A number of new features 
have been added to the Matrox realtime plug-in for Adobe Premiere, 
including enhanced editing tools and improved preview capabilities.

$ With XtremePreview, you can edit and preview numerous video and 
graphics layers without having to render. 

$ Professional vectorscope/waveform monitors let you examine the video 
signal components of your clips while making proc amp adjustments and 
other color corrections.

$ With advanced realtime detection, a red bar now appears over segments of 
the Timeline where effects are placed too close, indicating that the segments 
require rendering to avoid having dropped frames in your exported video. 
As well, when you play back the Timeline, any segments with dropped 
frames will be identified by a red bar.

$ You can now create realtime effects using up to two video clips and four 
single-frame graphics clips.

$ The Move & Scale effect (provided as a Matrox Effect add-on) lets you 
apply up to six 2D DVEs simultaneously in real time. For example, you can 
use this effect to create a realtime animated title with four single-frame 
graphics clips, keyed over two picture-in-picture effects on video.

$ The Old Movie effect (provided as a Matrox Effect add-on) lets you create 
an old film look on your clips by adding scratches, flicker, jitter, and grain.

$ Improvements have been made to the quality of chroma keys on PAL video.

$ Improved cropping controls let you easily apply crop settings to a Matrox 
effect directly in a cropping window, and you can select Simple edit to 
apply the same crop settings for the duration of your clip.
About these release notes
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$ You can now preview your realtime effects by toggling between tracks in 
the Matrox Effect Setup dialog box, and use Solo Mode to preview only 
the source for the effect that you’re editing.

$ You can now preview audio when you play or scrub in the Matrox Effect 
Setup dialog box, and ALT+drag the Positioner to render-scrub your effect 
(same as when you render-scrub on the Timeline). Video is displayed on 
your computer monitor as well as your NTSC or PAL video monitor.

$ You can select a different default effect for each effect category (advanced 
DVEs, page curls, etc.).

$ You can undo and redo most changes you make to the settings of an effect. 

¦ Note When you apply a Matrox video effect to a clip, the Matrox Effect 
Setup dialog box no longer automatically opens. Instead, you must click 
Setup beside your effect in the Effect Controls palette.

• Improved speed control Matrox X.tools now provides two methods of 
processing realtime speed changes in your Adobe Premiere projects 
(blended-field or repeat-field). Depending on whether your project is 
slow-paced video or fast-action video, you can choose the type of speed 
control that’s best suited for your video project.

• Single-frame export to file You can now choose to export a single frame 
of video from your Premiere Timeline to a Matrox DV/DVCAM .avi file.

• Matrox MediaTools improvements With Matrox MediaTools, you can 
now capture live video from your DV-1394 device. For example, you can use 
a copy stand and grab single-frame images from your live video. You can 
also easily select the type of file you want to create (.avi or .tga) when you 
grab single-frame images.

• Interleaved audio/video file support Matrox X.tools now creates .avi 
files with interleaved audio and video, instead of separate .avi files for video 
and .wav files for audio. You can, however, still use clips created with earlier 
versions of Matrox X.tools.

• New analog audio input selections Matrox X.tools now provides 
additional audio input selections for sound cards that do not have matching 
audio inputs and outputs, such as the SoundBlaster Audigy 2.

• WYSIWYG DirectShow support The WYSIWYG DirectShow Control 
Panel lets you display video from Microsoft DirectShow-compliant 
applications such as DVDit! SE or Windows MediaPlayer on your NTSC or 
PAL video monitor. This gives you a WYSIWYG (What You See Is What 
You Get) video display for checking how your clips appear on a TV or other 
interlaced monitor. You can also record your clips onto analog tape as they 
play back on your video monitor.
t’s new in this release of Matrox X.tools?
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• Matrox VFW capture driver  The Matrox VFW capture driver allows 
you to use your Matrox RT.X100 Xtreme hardware with your Video for 
Windows program to capture analog video using capture programs other 
than Adobe Premiere, such as Sonic Foundry’s Vegas Video. You can also 
use the Matrox VFW capture driver with many messenger and video 
conferencing programs (such as Microsoft NetMeeting) to send streaming 
video over the internet or your corporate intranet.

• Sonic ReelDVD Studio and DVDit! SE Matrox RT.X100 Xtreme now 
comes bundled with two DVD authoring programs: ReelDVD Studio for 
professional DVD authoring and DVDit! SE for simple DVD projects.

• Additional installation options You can switch your video standard 
without re-installing Matrox X.tools. You can also choose to install the 
Matrox Effect add-ons during your Matrox X.tools installation, and uninstall 
any Matrox Effect add-ons from the Start menu. As well, more Matrox 
Effect add-ons can be installed that were previously available only on 
fxzone.matrox.com.

¦ Note The sphere and cube effects are now installed with Matrox X.tools as 
standard realtime Matrox effects (previously available only as Matrox Effect 
add-ons).

• New and improved HTML Help Matrox X.tools has new and improved 
online Help, based on Microsoft’s HTML Help format. To properly view the 
online Help, you must have Microsoft Internet Explorer 4.0 or later (5.0 or 
later is recommended). 

Installing Matrox X.tools
To install this release of Matrox X.tools, you must first uninstall any previous 
release of Matrox X.tools software by choosing Start > Programs > Matrox 
X.tools > Uninstall. Uninstalling Matrox X.tools removes the Matrox realtime 
plug-in for Adobe Premiere, as well as Matrox MediaExport and Matrox 
MediaTools. You must also uninstall any Matrox Effect add-ons, including any 
new categories of effects downloaded from fxzone.matrox.com. To do this, use 
Add/Remove Programs in Windows Control Panel. 

Installing ReelDVD Studio
To install ReelDVD Studio, you must install Service Pack 1 for Windows XP 
(Home or Professional), or Service Pack 3 (or later) for Windows 2000 
Professional. If your Windows CD does not contain the appropriate service pack, 
you can obtain the software from the Microsoft web site at www.microsoft.com. 
If you already have Windows installed, you can check which service pack is 
installed by right-clicking My Computer, then choosing Properties > 
General.
Installing Matrox X.tools
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To activate ReelDVD Studio, you must click Register the first time you start 
ReelDVD Studio. If there is a problem connecting to the Sonic web site for the 
online registration, you’ll be prompted to manually activate your ReelDVD 
software. For details on installing ReelDVD Studio and activating your software, 
see your ReelDVD User Guide and ReelDVD Release Notes. (Ref# 29123 & 
29012)

Using the Windows Media version 9 video 
codec with MediaExport

Although MediaExport supports the Windows Media version 9 video codec, all 
of the Windows Media standard encoding profiles use the Windows Media 
version 8 video codec. To use the version 9 video codec to encode your video, 
you can customize a standard encoding profile by selecting the version 9 video 
codec from the Codec Options drop-down list. For more information, see 
“Modifying standard profile settings to create a customized profile” in the “Using 
Matrox MediaExport” chapter of your Matrox RT.X100 Xtreme Installation and 
User Guide.

Changes to the WYSIWYG DirectShow Control 
Panel

The WYSIWYG DirectShow Control Panel includes an option to let you mute 
the associated audio (.wav) file. By default, playback of the associated audio 
(.wav) file is enabled. 

Some DirectShow programs, such as DVDit! SE, automatically play back 
associated audio files for video clips. Therefore, if you hear an echo when 
playing back video on your NTSC or PAL video monitor, you should disable 
playback of the associated audio file by clearing Play associated audio (.wav) 
file, and restart your DirectShow application for the change to take effect. For 
details on how to configure the WYSIWYG DirectShow Control Panel, see the 
chapter “Using the WYSIWYG DirectShow Control Panel” in your Matrox 
RT.X100 Xtreme Installation and User Guide.

A note about DVD capacities
When choosing a data rate to create MPEG files for DVD authoring, make sure 
that you take into account the actual storage capacity of your DVD disk. This is 
because of a difference in terminology used by DVD manufacturers and accepted 
computer conventions. For example, commercially available 4.7 G (4.7 billion 
bytes) blank DVD disks have an actual storage capacity of 4.38 GB.
g the Windows Media version 9 video codec with MediaExport
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Last-minute operational limitations
The following operational limitations are in addition to those listed in the Matrox 
RT.X Readme for Matrox X.tools (choose Start > Programs > Matrox 
X.tools > Readme):

Adobe Premiere and the Matrox realtime plug-in
• If you perform two consecutive Stop Motion captures on a dual-processor 

system in Adobe Premiere, you may experience instability issues. (Ref# 
28055)

• Your video may appear jittery when playing back a segment containing more 
than four single-frame graphics clips from the Premiere Timeline. (Ref# 
28626)

• If you import non-full screen resolution graphics to use in your Premiere 
project, they may appear cropped on the Timeline. As a workaround, clear 
the Maintain Aspect Ratio option (Clip > Video Options > Maintain 
Aspect Ratio), save your project and close Premiere. When you restart 
Premiere, and re-open your project, the graphics will now display correctly. 
(Ref# 28998)

• If you use the Range Select Tool to shift or move the original clip used to 
create a virtual clip in Premiere, the Timeline may not refresh properly. 
(Ref# 29019)

• If you export video to an .m2v file using Matrox Realtime Export to Disk, 
you may see a black line at the top of your video when you play back the file. 
As a workaround, import the .m2v file to the Premiere Timeline, then export 
it again. You can also use Matrox MediaExport to create .m2v files because 
MediaExport uses the Ligos MPEG codec (which is not affected by this 
problem). MediaExport, however, can’t export your video in real time. (Ref# 
28815)

• If you’re using a Matrox P650, P750, or Parhelia display card, your video 
may not display correctly in the Monitor window when you choose File > 
Export Timeline > Print to Video in Adobe Premiere, or when you select 
the Full Screen or Zoom by 2 option in Premiere's Print to Video dialog 
box. As a workaround, right-click your Matrox PowerDesk HF icon on 
your desktop, choose Video Playback Settings, and clear Use video 
overlay. (Ref# 29186 & 29184)

• If you trim a project containing interleaved or non-interleaved .avi files in 
Adobe Premiere (Project > Utilities > Project Trimmer), you may lose 
the audio portion of your project. (Ref# 29241)

DV-1394 devices with Adobe Premiere
• Your DV tapes must contain continuous and consecutive time code. If you 

have to use a tape that hasn’t been striped to record video, however, continue 
Last-minute operational limitations
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recording for a few seconds after the material you want, then rewind the 
tape, and begin recording again over the material you don’t want to ensure 
that there are no gaps between recorded material. You can also use the 
edit-search function on your DV-1394 device. (Ref# 29026)

• If your video drive is nearly full (less than 500 MB), you may not receive an 
error message during DV-1394 captures in Premiere. To avoid this problem, 
make sure you have adequate space on your video drive before starting a 
capture. (Ref# 29108)

• If you choose to capture the 2nd audio stream when performing a 1394 
Audio Capture in Premiere (Project > Project Settings > Capture > 
A/V Inputs), the resulting .wav file may be one frame longer or shorter than 
your original clip. (Ref# 29171)

• If you capture 32 kHz, 12-bits/sample audio from a DV-1394 device, the 
audio may sound distorted during capture, and the resulting file may be 
audibly distorted. For best performance, use only 48 kHz, 16-bits/sample 
audio in your projects. A fix for this limitation will soon be available in the 
Support section of our website at www.matrox.com/videoweb/support. 
(Ref# 29233)

DVDit! SE and other DVD authoring programs
• To avoid problems importing .avi files into DVDit! SE, you must install 

Service Pack 1 for Windows XP, or Service Pack 3 for Windows 2000. (Ref# 
29034)

• If you want to import .m2v files into DVDit! SE on a Windows 2000 
operating system, you may have to disable the Matrox WYSIWYG 
DirectShow Control Panel. For details, see the “Using the WYSIWYG 
DirectShow Control Panel” chapter of your Matrox RT.X100 Xtreme 
Installation and User Guide. (Ref# 29093)

Installation and general operation
• If you use Symantec’s Norton Utilities on your Matrox RT.X100 Xtreme 

system, you may experience errors starting the RT.X menu. (Ref# 28988)

• If you receive an IKernel.exe application error message when installing or 
uninstalling Matrox X.tools, download the fix available in the Support 
Knowledgebase (document ID Q108020) on the InstallShield web site at 
http://support.installshield.com/kb/ (Ref# 29080)

Matrox MediaTools
• To avoid problems with MediaTools, do not press any of the buttons on your 

DV-1394 device during a scan and capture. (Ref# 28472)

• On certain DV-1394 devices, you may experience audio sync problems when 
capturing live video in MediaTools. As a workaround, leave a tape in the 
t-minute operational limitations
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cassette compartment of your DV-1394 device when capturing live video. 
(Ref# 29150)

Matrox WYSIWYG DirectShow Control Panel
• There may be operational limitations when using the WYSIWYG 

DirectShow Control Panel with certain DirectShow programs. By default, 
the Matrox WYSIWYG DirectShow output to your NTSC or PAL monitor is 
enabled. Some DirectShow applications, however, may not display the video 
properly. If this happens, you can disable the display on your video monitor 
by clicking the Disable button. For details, see the “Using the WYSIWYG 
DirectShow Control Panel” chapter of your Matrox RT.X100 Xtreme 
Installation and User Guide. For more information on supported programs 
and video formats, and a list of programs and video formats we’ve found to 
be unsuitable for use with the WYSIWYG DirectShow Control Panel, see 
the Frequently asked questions (FAQs) in the RT.X Support section of our 
web site at www.matrox.com/videoweb/support.

• On a Windows 2000 system, you may lose video or audio if you cue multiple 
.avi files to play back in Windows MediaPlayer. (Ref# 29072)
Last-minute operational limitations
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